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Screen Layout
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Menus

When you begin to explore Word 2000, you will notice a significant change in the menu structure if you are familiar with previous versions of Word. The menus in Word 2000 display only the commands you have recently used.  To view all options in each menu, you must click the double arrows at the bottom of the menu. The images below show the Format menu collapsed (left) and expanded (right) after the double arrows at the bottom of the menu were clicked:
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Follow the steps below to display menus similar to previous versions of Word with all the choices listed initially:

· Select View|Toolbars|Customize from the menu bar. 

· Click on the Options tab. 

· Uncheck the Menus show recently used commands first check box.
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Shortcut Menus

These features allow you to access various Word commands faster than using the options on the menu bar. View shortcut menus by right-clicking with the mouse. The options on this menu will vary depending on the element that was right-clicked. For example, the shortcut menu below is produced by right-clicking on a bulleted list. 
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Actions such as "Decrease Indent" and "Increase Indent" are only applicable to lists and therefore only appear on the list shortcut menu. The shortcut menus are helpful because they only display the options that can be applied to the item that was right-clicked and, therefore, prevent searching through the many menu options.

Toolbars

Many toolbars displaying shortcut buttons are also available to make editing and formatting quicker and easier. Select View|Toolbars from the menu bar to select the toolbars. The toolbars that are already displayed on the screen are checked. Add a toolbar simply by clicking on the name.
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Customizing Toolbars

There may be certain actions on a toolbar that you do not use and there may also be commands that you execute often but that are not located on any toolbar. Word toolbars can be customized so these commands can be added and deleted.

· Select

· View|Toolbars|Customize and click the Commands tab.
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· By highlighting the command categories in the Categories box, the choices will change in the Commands box to the right. 

· Select the command you would like to add to the toolbar by selecting it in the Commands box. 

· Drag the command with the mouse to the desired location on the toolbar and release the mouse button. 

· Remove a button from the toolbar by clicking and dragging the button off the toolbar. 
	


Creating and Opening Documents

There are several ways to create new documents, open existing documents, and save documents in Word:

Create a New Document 
· Click the New Document button on the menu bar. [image: image9.png]



· Choose File|New from the menu bar. 

· Press CTRL+N (depress the CTRL key while pressing "N") on the keyboard. 

Open an Existing Document 
· Click the Open File button on the menu bar. [image: image10.png]



· Choose File|Open from the menu bar. 

· Press CTRL+O on the keyboard. 

Each method will show the Open dialog box. Choose the file and click the Open button. 
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Save a Document 

· Click the Save button on the menu bar. [image: image12.png]



· Select File|Save from the menu bar. 

· Press CTRL+S on the keyboard. 

Renaming Documents

To rename a Word document while using the program, select File|Open and find the file you want to rename. Right-click on the document name with the mouse and select Rename from the shortcut menu. Type the new name for the file and press the ENTER key.
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Working on Multiple Documents

Several documents can be opened simultaneously if you are typing or editing multiple documents at once.  All open documents are listed under the Window menu as shown below. The current document has a checkmark beside the file name. Select another name to view another open document or click the button on the Windows taskbar at the bottom of the screen.
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Close a Document 

Close the current document by selecting File|Close or click the Close icon if it's visible on the Standard Toolbar. [image: image15.png]



Typing and Inserting Text

To enter text, just start typing! The text will appear where the blinking cursor is located. Move the cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the left button. The keyboard shortcuts listed below are also helpful when moving through the text of a document:

	Move Action
	Keystroke

	Beginning of the line
	HOME

	End of the line
	END

	Top of the document
	CTRL+HOME

	End of the document
	CTRL+END


Selecting Text

To change any attributes of text it must be highlighted first. Select the text by dragging the mouse over the desired text while keeping the left mouse button depressed, or hold down the SHIFT key on the keyboard while using the arrow buttons to highlight the text. The following table contains shortcuts for selecting a portion of the text:

	Selection
	Technique

	Whole word
	double-click within the word

	Whole paragraph
	triple-click within the paragraph

	Several words or lines
	drag the mouse over the words, or hold down SHIFT while using the arrow keys

	Entire document
	choose Edit|Select All from the menu bar, or press CTRL+A


Deselect the text by clicking anywhere outside of the selection on the page or press an arrow key on the keyboard.

Deleting Text

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to the left of the cursor and Delete will erase text to the right. To delete a large selection of text, highlight it using any of the methods outlined above and press the DELETE key. 

Formatting Text

The formatting toolbar is the easiest way to change many attributes of text. If the toolbar as shown below isn't displayed on the screen, select View|Toolbars and choose Formatting.
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· Style Menu - Styles are explained in detail later in this tutorial. 

· Font Face - Click the arrowhead to the right of the font name box to view the list of fonts available. Scroll down to the font you want and select it by clicking on the name once with the mouse. A serif font (one with "feet" circled in the illustration below) is recommended for paragraphs of text that will be printed on paper as they are most readable. The following graphic demonstrates the difference between serif (Times New Roman on the left) and sans-serif ("no feet", Arial on the right) fonts.
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· Font Size - Click on the white part of the font size box to enter a value for the font size or click the arrowhead to the right of the box to view a list of font sizes available. Select a size by clicking on it once. A font size of 10 or 12 is best for paragraphs of text.

· Font Style - Use these buttons to bold, italicize, and underline text.

· Alignment - Text can be aligned to the left, center, or right side of the page or it can be justified across the page. 

· Numbered and Bulleted Lists - Lists are explained in detail later in this tutorial. 

· Increase/Decrease Indent - Change the indentation of a paragraph in relation to the side of the page.

· Outside Border - Add a border around a text selection.

· Highlight Color - Use this option to change the color behind a text selection. The color shown on the button is the last color used. To select a different color, click the arrowhead next to the image on the button.

· Text Color - This option changes the color of the text. The color shown on the button is the last color chosen. Click the arrowhead next to the button image to select another color.

The Font dialog box allows you to choose from a larger selection of formatting options. Select Format|Font from the menu bar to access the box. 
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Format Painter [image: image19.png]



A handy feature for formatting text is the Format Painter located on the standard toolbar. For example, if you have formatting a paragraph heading with a certain font face, size, and style and you want to format another heading the same way, you do not need to manually add each attribute to the new headline. Instead, use the Format Painter by following these steps: 

· Place the cursor within the text that contains the formatting you want to copy. 

· Click the Format Painter button in the standard toolbar. Notice that your pointer now has a paintbrush beside it. 

· Highlight the text you want to add the same format to with the mouse and release the mouse button. 

To add the formatting to multiple selections of text, double-click the Format Painter button instead of clicking once.  The format painter then stays active until you press the ESC key to turn it off. 

Undo [image: image20.png]



Feel free to experiment with various text styles. You can always undo your last action by clicking the Undo button on the standard toolbar or selecting Edit|Undo... from the menu bar. Click the Redo button on the standard toolbar or select Edit|Redo... to erase the undo action.

Paragraph Attributes

Format a paragraph by placing the cursor within the paragraph and selecting Format|Paragraph from the menu bar.
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Moving (Cutting) Text [image: image22.png]



Highlight the text that will be moved and select Edit|Cut from the menu bar, click the Cut button on the standard tool bar, or press CTRL+X at once. This will move the text to a clipboard.

To move a small amount of text a short distance, the drag-and-drop method may be quicker. Highlight the text you want to move, click the selection with the mouse, drag the selection to the new location, and release the mouse button.

Copying Text [image: image23.png]



To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or press CTRL+C to copy the text to the clipboard.

Paste Text [image: image24.png]



To paste cut or copied text, move the cursor to the location you want to move the text to and select Edit|Paste from the menu bar, click the Paste button on the standard toolbar, or press CTRL+V. 

The Clipboard

The last 12 elements that were cut or copied are placed onto Word's clipboard. You can view the elements on the clipboard by selecting View|Toolbars|Clipboard from the menu bar.
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Place the mouse arrow over each element in the clipboard to view the contents of each item and click on an element to add its contents to the document. Click Paste All to add all of the items to the document at once. Click the Clear Clipboard button (the icon with an "X" over the clipboard image) to clear the contents of the clipboard.

Columns [image: image26.png]



To quickly place text in a column format, click the Columns button on the standard toolbar and select the number of columns by dragging the mouse over the diagram.
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For more column options, select Format|Columns from the menu bar. The Columns dialog box allows you to choose the properties of the columns. Select the number and width of the columns from the dialog box.

[image: image28.png]remove columns

select a
preset
column
amangement

enter the
number of
columns

enter the widih
of each column

check f all
columns are
‘equal width

Columns

o
Cancel

—

Number of columns: T Line between
it and spacing
Col#: with:
|
Rl |

=

¥ Equal column width

apply o

[whle document <

I start new column

check to place
averticalline:
between
columns

enter the
amount of
space between
columns




Drop Caps

A drop cap is a large letter that begins a paragraph and drops through several lines of text as shown below.
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Add a drop cap to a paragraph by following these steps:

· Place the cursor within the paragraph whose first letter will be dropped. 

· Select Format|Drop Cap from the menu bar. 

· The Drop Cap dialog box allows you to select the position of the drop cap, the font, the number of lines to drop, and the distance from the body text. 

· Click OK when all selections have been made. 

· To modify a drop cap, select Format|Drop Cap again to change the attributes, or click on the letter and use the handles to move and resize the letter. 

The use of styles in Word will allow you to quickly format a document with a consistent and professional look. Paragraph and character styles can be saved for use in many documents.
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Applying a Style

· Place the cursor in the paragraph where the style will be applied. 

· Click the Style drop-down menu on the Formatting toolbar and select a style by clicking on it. 

· To apply the same style to multiple paragraphs, double click the Format Painter button [image: image31.png]


on the standard toolbar and click in all the paragraphs that the style should be applied to. Press the ESC key to disable the Format Painter. 

Apply a Style from the Style Dialog Box

Choose from a larger selection of styles from the Style dialog box.
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· Click in the paragraph you want to add a style to. 

· Select Format|Style... from the menu bar. 

· From the List drop-down menu, choose All styles to view all the styles available. 

· The styles are displayed in the Styles list. Preview each style by clicking once on the name. Paragraph styles are preceded by the paragraph symbol ([image: image33.png]


) and character styles are preceded by an "a" icon ([image: image34.png]


). A pointer arrow is located next to the current style. Highlight the style you want to apply to the paragraph and click Apply. 

Create a New Style from a Model

To create a style from text that is already formatted in a document, follow these steps:

· Place the cursor in the paragraph you would like to set as a new style. 

· Click the Style box on the formatting toolbar so the style name is highlighted.
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· Delete the text in the field and type the name of the new style. 

· Press the ENTER key to save the new style. 

Create a Simple Style from the Style Dialog Box

· Select Format|Style... from the menu bar and click the New button on the Style dialog box to access the New Style dialog box. 
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· Type the name for the new style in the Name field. 

· Select "Paragraph" or "Character" from the Style type drop-down menu. 

· Click the Format button at the bottom of the window and choose the paragraph element that will be formatted for the style. Continue to make changes from the options from the Format button menu, making changes to the dialog boxes for each element you choose. 

· Click OK to set the style and close the New Style dialog box. 

· Click Apply on the Style dialog box to apply the new style to the current paragraph. 

Modify or Rename a Style

An existing style can be changed from the Style dialog box.

· Select Format|Style... from the menu bar. 

· Highlight the style from the Styles list that you want to modify and click the Modify button.
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· Use the same methods to modify the style from the Modify Style dialog box that were used for the New Style box. 

· To only rename the style, type a new name in the Name field. 

· Click OK when you are finished making modifications. 

· Click Apply to update the style in the document. 

Delete a Style

Preset styles created by Word cannot be deleted, but to delete a style you have made, follow these steps:

· Select Format|Style... from the menu bar 

· Highlight the style from the Styles list that you want to delete. 

· Click the Delete button. 

· You will be asked if you really want to delete the style. Click Yes. 

· Click Close on the dialog box. 
To create a bulleted or numbered list, use the list features provided by Word. 

Bulleted and Numbered Lists 

· Click the Bulleted List button [image: image38.png]


or Numbered List button [image: image39.png]


on the formatting toolbar. 

· Type the first entry and press ENTER.  This will create a new bullet or number on the next line. If you want to start a new line without adding another bullet or number, hold down the SHIFT key while pressing ENTER. 

· Continue to typing entries and press ENTER twice when you are finished typing to end the list. 

Use the Increase Indent [image: image40.png]


and Decrease Indent [image: image41.png]


buttons on the formatting toolbar to create lists of multiple levels.

NOTE: You can also type the text first, highlight the section, and press the Bulleted List or Numbered List buttons to add the bullets or numbers. 

Nested Lists

To create a nested list, such as a numbered list inside of a bulleted list, follow these steps:

· Type the list and increase the indentation of the items that will make up the nested list by clicking the Increase Indent button for each item.
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· Highlight the items and click the Numbered List button on the formatting toolbar. 

Formatting Lists

The bullet image and numbering format can be changed by using the Bullets and Numbering dialog box.

· Highlight the entire list to change all the bullets or numbers, or
Place the cursor on one line within the list to change a single bullet. 

· Access the dialog box by selecting Format|Bullets and Numbering from the menu bar or by right-clicking within the list and selecting Bullets and Numbering from the shortcut menu.
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· Select the list style from one of the seven choices given, or click the Picture... button to choose a different icon. Click the Numbered tab to choose a numbered list style. 

· Click OK when finished. 

	« Lists
	Tables
	Graphics »
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Tables are used to display data and there are several ways to build them in Word. Begin by placing the cursor where you want the table to appear in the document and choose one of the following methods.

Insert a Table

There are two ways to add a table to the document using the Insert feature:

Click the Insert Table button on the standard toolbar. Drag the mouse along the grid, highlighting the number of rows and columns for the table.
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Or, select Table|Insert|Table from the menu bar. Select the number of rows and columns for the table and click OK.
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Draw the Table

A table can also be drawn onto the document:

Draw the table by selecting Table|Draw Table from the menu bar. The cursor is now the image of a pencil and the Tables and Borders toolbar has appeared.
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Draw the cells of the table with the mouse. If you make a mistake, click the Eraser button [image: image48.png]<7



and drag the mouse over the area to be deleted. 

To draw more cells, click on the Draw Table button [image: image49.png]


. 

Inserting Rows and Columns

Once the table is drawn, insert additional rows by placing the cursor in the row you want to be adjacent to. Select Table|Insert|Rows Above or Rows Below. Or, select an entire row and right-click with the mouse. Choose Insert Rows from the shortcut menu.

Much like inserting a row, add a new column by placing the cursor in a cell adjacent to where the new column will be added. Select Table|Insert|Columns to the Left or Columns to the Right. Or, select the column, right-click with the mouse, and select Insert Columns.

Moving and Resizing a Table

A four-sided moving arrow and open box resizing handle will appear on the corners of the table if the mouse is placed over the table. Click and drag the four-ended arrow to move the table and release the mouse button when the table is positioned where you want it. Click and drag the open box handle to resize the table. Change the column widths and row heights by clicking the cell dividers and dragging them with the mouse.
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Tables and Borders Toolbar

The Tables and Borders toolbar allows you to add border styles, shading, text effects, alignment, and more options to your table. Access the toolbar by clicking Table|Draw Table or View|Toolbars|Tables and Borders.
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You will need to highlight the cells of the table you want to format. Click and drag the mouse over the cells, or use the following shortcuts:

	Selection
	Menu Method
	Mouse Method

	One cell
	Table|Select|Cell
	Click the bottom, left corner of the cell when a black arrow appears 

	One row
	Table|Select|Row
	Click outside the table to the left of the row

	One column
	Table|Select|Column
	Click outside the table above the column when a black arrow appears

	Several rows
	(none)
	Click outside the table to the left of the row and drag the mouse down

	Several columns
	(none)
	Click outside the table above the column

	Entire table
	Table|Select|Table
	Triple-click to the left of the table


Table Properties

Use the Table Properties dialog box to modify the alignment of the table with the body text and the text within the table. Access the box by selecting Tables|Table Properties.
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Size - Check the Preferred width box and enter a value if the table should be an exact width. 

Alignment - Highlight the illustration that represents the alignment of the table in relation to the text of the document. 

Text wrapping - Highlight "None" if the table should appear on a separate line from the text or choose "Around" if the text should wrap around the table. 

Borders and Shading - Select from a number of border styles, colors, and widths. Click the Shading tab to change the background color and pattern.
[image: image53.png]rders and Shading

|

Setting

None

Box.

arid

Custom

etrier | g |

Style:

Colr

Automatic

widh

vt

Preview

Clckon disgram below or use:
buttons Eo apply borders

Z0 EEE N
Apply to:
rade =

& Cancel





Options - Click the Options button on the Table Properties window. To change the spacing between the document text and the table borders under Default cell margins. Check the Allow spacing between cells box and enter a value to add space between the table cells.
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 Adding Clip Art

To add a clip art image from the Microsoft library to a document, follow these steps:

Select Insert|Picture|Clip Art from the menu bar.
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To find an image, click in the white box following Search for clips. Delete the words "Type one or more words. . ." and enter keywords describing the image you want to use.
- OR -
Click one of the category icons. 

Click once on the image you want to add to the document and the following popup menu will appear:
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Insert Clip to add the image to the document.

Preview Clip to view the image full-size before adding it to the document. Drag the bottom, right corner of the preview window to resize the image and click the "x" close button to end the preview.
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Add Clip to Favorites will add the selected image to your favorites directory that can be chosen from the Insert ClipArt dialog box. 

Find Similar Clips will retrieve images similar to the one you have chosen. 

Continue selecting images to add to the document and click the Close button in the top, right corner of the Insert ClipArt window to stop adding clip art to the document.

Add An Image from a File

Follow these steps to add a photo or graphic from an existing file:

Select Insert|Picture|From File on the menu bar.

Click the down arrow button on the right of the Look in: window to find the image on your computer. 

Highlight the file name from the list and click the Insert button.
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Editing A Graphic 

Activate the image you wish to edit by clicking on it once with the mouse. Nine handles will appear around the graphic. Click and drag these handles to resize the image. The handles on the corners will resize proportionally while the handles on the straight lines will stretch the image. More picture effects can be changed using the Picture toolbar. The Picture toolbar should appear when you click on the image. Otherwise, select View|Toolbars|Picture from the menu bar to activate it.
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Insert Picture will display the image selection window and allows you to change the image.

Image Control allows to to make the image grayscale, black and white, or a watermark.

More/Less Contrast modifies the contrast between the colors of the image.

More/Less Brightness will darken or brighten the image.

Click Crop and drag the handles on the activated image to delete outer portions of the image.

Line Style will add a variety of borders to the graphic.

Text Wrapping will modify the way the document text wraps around the graphic.

Format Picture displays all the image properties in a separate window.

Reset Picture will delete all the modifications made to the image. 

Auto Shapes

The AutoShapes toolbar will allow you to draw many different geometrical shapes, arrows, flow chart symbols, stars, and banners on the document. Activate the AutoShapes toolbar by selecting Insert|Picture|AutoShapes or View|Toolbars|AutoShapes from the menu bar, or clicking the AutoShapes button on the Drawing toolbar. Click each button on the toolbar to view the options for drawing the shape.
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Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, arrow, or double-ended arrow from the first row of options by clicking the respective button. Click in the document where you would like the line to begin and click again where it should end. To draw a curved line or freeform shape, select curved lines from the menu (first and second buttons of second row), click in the document where the line should appear, and click the mouse every time a curve should begin. End creating the graphic by clicking on the starting end or pressing the ESC key. To scribble, click the last button in the second row, click the mouse in the document and hold down the left button while you draw the design. Let go of the mouse button to stop drawing.

Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from many two- and three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method to draw the shape in the document. When the shape has been made, it can be resized using the open box handles and other adjustments specific to each shape can be modified using the yellow diamond handles.
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Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional arrows. Drag-and-drop the arrow in the document and use the open box and yellow diamond handles to adjust the arrowheads. Each AutoShape can also be rotated by first clicking the Free Rotate button on the drawing toolbar [image: image62.png]


. Click and drag the green handles around the image to rotate it. The tree image below was created from an arrow rotated 90 degrees.
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Flow Chart - Choose from the flow chart menu to add flow chart elements to the document and use the line menu to draw connections between the elements.

Stars and Banners - Click the button to select stars, bursts, banners, and scrolls. 

Call Outs - Select from the speech and thought bubbles, and line call outs. Enter the call out text in the text box that is made.

More AutoShapes - Click this button to choose from a list of clip art categories. 

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click and drag the gray bar across the top of the submenus off of the toolbar and it will become a separate floating toolbar.
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AutoCorrect

Word automatically corrects many commonly misspelled words and punctuation marks with the AutoCorrect feature. To view the list of words that are automatically corrected, select Tools|AutoCorrect. This may be a hidden feature so click the double arrows at the bottom of the Tools menu listing if the AutoCorrect choice is not listed.
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Many options including the accidental capitalization of the first two letters of a word and capitalization of the first word of the sentence can be automatically corrected from this page. If there are words you often misspell, enter the wrong and correct spellings in the Replace and With fields.

Spelling and Grammar Check

Word will automatically check for spelling and grammar errors as you type unless you turn this feature off. Spelling errors are noted in the document with a red underline. Grammar errors are indicated by a green underline. To disable this feature, select Tools|Options from the menu bar and click the Spelling and Grammar tab on the dialog box. Uncheck "Check spelling as you type" and "Check grammar as you type", and click OK.

To use the spelling and grammar checker, follow these steps:

Select Tools|Spelling and Grammar from the menu bar. 

The Spelling and Grammar dialog box will notify you of the first mistake in the document and misspelled words will be highlighted in red.
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If the word is spelled correctly, click the Ignore button or click the Ignore All button if the word appears more than once in the document. 

If the word is spelled incorrectly, choose one of the suggested spellings in the Suggestions box and click the Change button or Change All button to correct all occurrences of the word in the document. If the correct spelling is not suggested, enter the correct spelling in the Not In Dictionary box and click the Change button. 

If the word is spelled correctly and will appear in many documents you type (such as your name), click the Add button to add the word to the dictionary so it will no longer appear as a misspelled word. 

As long as the Check Grammar box is checked in the Spelling and Grammar dialog box, Word will check the grammar of the document in addition to the spelling. If you do not want the grammar checked, remove the checkmark from this box. Otherwise, follow these steps for correcting grammar:

If Word finds a grammar mistake, it will be shown in the box as the spelling errors. The mistake is highlighted in green text.
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Several suggestions may be given in the Suggestions box. Select the correction that best applies and click Change. 

If no correction is needed (Word is often wrong more than it is right), click the Ignore button. 

Synonyms

Word 2000 has a new feature for finding synonyms. Simply right-click on the word and select Synonyms from the shortcut menu. From the list of suggested words, highlight the word you would like to use or click Thesaurus... for more options.
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Thesaurus

To use the thesaurus, select Tools|Language|Thesaurus from the menu bar or select it from the Synonyms shortcut menu as detailed above.
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A list of meanings and synonyms are given on the windows. Double-click on the words in the Meanings box or click the Look Up button to view similar words. Double-click words in the Replace with Synonym box to view synonyms of those words. Highlight the word you would like to add and click the Replace button.

Page Margins

The page margins of the document can be changed using the rulers on the page and the Page Setup window. The ruler method is discussed first:

Move the mouse over the area where the white ruler changes to gray.
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When the cursor becomes a double-ended arrow, click with the mouse and drag the margin indicator to the desired location. 

Release the mouse when the margin is set. 

The margins can also be changed using the Page Setup dialog box:

Select File|Page Setup and choose the Margins tab in the dialog box.
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Enter margin values in the Top, Bottom, Left, and Right boxes. The Preview window will reflect the changes. 

If the document has Headers and/or Footers, the distance this text appears from the edge of the page can be changed. 

Click OK when finished.

Page Size and Orientation

Change the orientation page within the Page Setup dialog box.

Select File|Page Setup and choose the Paper Size tab.
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Select the proper paper size from the drop-down menu. 

Change the orientation from Portrait or Landscape by checking the corresponding radio button.

Headers and Footers

A header is text that is added to the top margin of every page such as a document title or page number and a footer is text added to the bottom margin.  Follow these steps to add or edit headers and footers in the document:

Select View|Header and Footer from the menu bar. The Header and Footer toolbar will appear and the top of the page will be highlighted as shown below.
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Type the heading in the Header box. You may use many of the standard text formatting options such as font face, size, bold, italics, etc. 

Click the Insert AutoText button to view a list of quick options available. 

Use the other options on the toolbar to add page numbers, the current date and time. 

To edit the footer, click the Switch Between Header and Footer button on the toolbar. 

When you are finished adding headers and footers, click the Close button on the toolbar. 

Page Numbers

Follow these instructions for another way to add page numbers to a document.

Select Insert|Page Numbers from the menu bar and the following dialog box will appear.
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Select the position of the page numbers by choosing "Top of page" or "Bottom of page" from the Position drop-down menu. 

Select the alignment of the page numbers in the Alignment drop-down menu. 

If you do not want the page number to show on the first page (if it is a title page, for example), uncheck the Show number of first page box. 

Click OK when finished. 

Print Preview and Printing

Preview your document by clicking the Print Preview button on the standard toolbar or by selecting File|Print Preview. When the document is ready to print, click the Print button from the Print Preview screen or select File|Print.

Macros are advanced features that can speed up editing or formatting you may perform often in a Word document. They record sequences of menu selections that you choose so that a series of actions can be completed in one step. 

Recording A Macro

To record a macro, follow these steps: 

Click Tools|Macro|Record New Macro on the menu bar.
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Name the macro in the Macro name field. This name cannot contain spaces and or begin with a number. 

From the Store macro in drop-down box, select the document you would like the macro to be associated with or choose "All Documents" be able to use the macro in any document. 

Enter a description of the macro in the Description field. This is for your reference only so you remember what the macro does. 

Click OK to begin recording. 

Select options from the drop-down menus and Word will record the options you choose from the dialog boxes, such as changing the margins on the Page Setup window. Select only options that modify the document. Word will not record toggle actions such as View|Toolbars that have no effect on the document itself. 

The recording toolbar will allow you to stop, pause, and resume recording.
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Click the Stop button the recording toolbar. The macro is now saved. 

Running A Macro

To run an existing macro, follow these steps.

Select Tools|Macro|Macros from the menu bar. 

From the Macros window, highlight the Macro name in the list and click Run.
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If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL and press PAUSE). 

Word will automatically create a Table of Contents page if a document is designed using Heading and Paragraph styles (see the Styles section). Follow the steps on this page to create a Table of Contents.

Mark Table of Contents Entries

Highlight a heading that you would like to appear in the Table of Contents (TOC). 

Press ALT+SHIFT+O and the Mark Table of Contents Entry box will appear.
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Entry - Rename the entry if you would like a different heading to appear in the TOC. 

Table identifier - Select "C". 

Level - Choose "1" for first-level heading, "2" for second-level heading, etc. 

Click the Mark button. 

The document will be toggled to "reveal codes" view and notice the TOC field code. To hide all codes click the Show/Hide codes button [image: image80.png]


on the standard toolbar. 

Select another heading to add to the TOC, or click the Close button on the Mark Table of Contents Entry dialog box. 

Generate a Table of Contents

After you have marked all the headings for your TOC, follow these steps to generate the Table of Contents.

Place the cursor where you would like the TOC to appear in the document. 

Select Insert|Index and Tables from the menu bar.
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Customize the appearance of the TOC from the Table of Contents tab. You may choose a preset design from the Formats drop-down menu. A preview of each design will be shown in the Print Preview window. 

Check the Show page numbers box if you would like page numbers to show on the TOC. Check the Right align page numbers box if the page numbers should appear on the right side, then select the Tab leader between the heading and the page number. Uncheck the box if the page numbers should appear right next to the heading. 

Click OK. 
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